Importing Metadata by Using the Oracle Business Intelligence Enterprise Edition Bridge
IBM InfoSphere Information Server
Version 9 Release 1

Importing Metadata by Using the Oracle Business Intelligence Enterprise Edition Bridge
Before using this information and the product that it supports, read the information in "Notices and trademarks" on page.
## Contents

<table>
<thead>
<tr>
<th>Chapter 1. Importing metadata from business intelligence tools</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business intelligence metadata</td>
<td>1</td>
</tr>
<tr>
<td>Chapter 2. Importing metadata by using InfoSphere Metadata Asset Manager</td>
<td>3</td>
</tr>
<tr>
<td>Chapter 3. Oracle Business Intelligence Enterprise Edition bridge reference</td>
<td>5</td>
</tr>
<tr>
<td>Upgrade requirements for users of Oracle Business Intelligence (OBI) Enterprise Edition bridge</td>
<td>8</td>
</tr>
<tr>
<td>Chapter 4. Identity parameters for imported assets</td>
<td>9</td>
</tr>
<tr>
<td>Chapter 5. Business intelligence assets</td>
<td>11</td>
</tr>
<tr>
<td>Appendix A. Product accessibility</td>
<td>17</td>
</tr>
<tr>
<td>Appendix B. Contacting IBM</td>
<td>19</td>
</tr>
<tr>
<td>Appendix C. Accessing and providing feedback on the product documentation</td>
<td>21</td>
</tr>
<tr>
<td>Notices and trademarks</td>
<td>23</td>
</tr>
<tr>
<td>Index</td>
<td>27</td>
</tr>
</tbody>
</table>
Chapter 1. Importing metadata from business intelligence tools

You can use bridges to import business intelligence (BI) metadata into the metadata repository of IBM® InfoSphere® Information Server. The imported metadata includes BI reports, BI models, and related implemented data resources such as database tables.

Business intelligence metadata

When you import BI metadata into the metadata repository, you can study the components of BI reports and BI models and how they are related. You can track database tables and columns that the BI reports reference, and the jobs that use the columns.

Business intelligence reporting is the means of publishing, distributing, and reviewing data results and information. Analysts must be able to understand the meaning and authenticity of BI reports, which are generated against data sources such as marts or warehouses. You might need to know when the content that feeds a BI report was last updated, and which InfoSphere DataStage® and QualityStage® jobs or other other processes were sequenced during the update. Lineage and analysis reports in InfoSphere Metadata Workbench can display the complete data flows that transform and populate the source data that underlies the BI reports, thus satisfying requirements for data governance and data trust.

For a full list of supported BI bridges, see the technote List of supported bridges for InfoSphere Information Server Version 9.1: [http://www.ibm.com/support/docview.wss?&uid=swg27025125](http://www.ibm.com/support/docview.wss?&uid=swg27025125) Not all BI bridges import BI reports.

BI reports are the report templates that are created within BI reporting tools such as the following:
- IBM Cognos® Report Studio or Query Studio
- SAP BusinessObjects Desktop Intelligence, Web Intelligence, or Crystal Reports
- Oracle Business Intelligence Report Publisher

BI reports include BI report fields. Some report fields are non-data fields, including page numbers and section headers. Other report fields are data fields, which retrieve or calculate data from a data source. BI reports also include BI queries and query members, which source and aggregate the information to display from BI models. BI models are created within modeling tools such as Cognos Framework Manager and BusinessObjects Designer.

You can use assign stewards and glossary terms to business intelligence reports in InfoSphere Business Glossary InfoSphere Metadata Workbench. You can edit their descriptions and business names in the metadata workbench.

For best results when you import BI metadata, familiarize yourself with the following concepts and functionality:
<table>
<thead>
<tr>
<th>To answer this question</th>
<th>Read this</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I ensure that my imports are efficient and successful?</td>
<td>Importing and managing assets by using InfoSphere Metadata Asset Manager (<a href="http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/ct_imam_top-level.html">http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/ct_imam_top-level.html</a>)</td>
</tr>
<tr>
<td>Which assets are imported and used by suite tools, and how are they organized?</td>
<td>Common metadata assets (<a href="http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.metadata.common.doc/topics/ct_common_metadata_assets.html">http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.metadata.common.doc/topics/ct_common_metadata_assets.html</a>)</td>
</tr>
<tr>
<td>Which BI assets are imported and used?</td>
<td>Business intelligence assets (<a href="http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.metadata.common.doc/topics/c_BI_assets.html">http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.metadata.common.doc/topics/c_BI_assets.html</a>)</td>
</tr>
<tr>
<td>How do I view and report on the relationships between the imported BI metadata and the InfoSphere DataStage and QualityStage jobs that use the database tables and columns that reports are based on?</td>
<td>Creating data lineage, business lineage and impact analysis reports in InfoSphere Metadata Workbench (<a href="http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mdwb.doc/topics/ct_analyzingMetadataRelationships.html">http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mdwb.doc/topics/ct_analyzingMetadataRelationships.html</a>)</td>
</tr>
</tbody>
</table>
Chapter 2. Importing metadata by using InfoSphere Metadata Asset Manager

You can import by using a bridge or connector that is on any computer that is designated as a metadata interchange server. You specify connection information and information about the source metadata, and choose to run either an express import or a managed import.

**Before you begin**

You must have the role of Common Metadata Importer or Common Metadata Administrator.

Ensure that you meet all prerequisites for importing metadata:

- [Installing InfoSphere Metadata Asset Manager and bridges](http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/wsisinst_install_imam.html)
- [Preparing to use InfoSphere Metadata Asset Manager](http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/t_first_steps.html)
- [Prerequisites for using the Oracle Business Intelligence (OBI) Enterprise Edition bridge](http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/t_first_steps.html)

**About this task**

You create an import area by running an import. The import area is created whether you run an express import or a managed import.

When you run a managed import, you can closely study the metadata assets in the import. You can preview the effects that the import might have on the repository. You can take time to fix problems in the source metadata, or reimport with other parameters.

An express import saves time when you have high confidence in the contents of your import source. By default, an express import requires that you preview the result of sharing to the metadata repository if repository assets will be deleted as a result of the import. Your administrator can change the defaults to allow automatic sharing in all cases or to require previews in all cases.

**Procedure**

1. Log in to InfoSphere Metadata Asset Manager by clicking the desktop icon or entering the URL for the services tier computer in your browser. The URL is `http_or_https://host:port/ibm/imam/console`.
2. On the **Import** tab, click **New Import Area**.
3. In the **New Import Area** window, take the following steps:
   a. Specify a unique name and a description for the import area.
   b. Select the metadata interchange server from which you want to run the import.
   c. From the list of bridges and connectors, select **Oracle Business Intelligence Enterprise Edition**.
d. Click Next.

4. For connector imports, select or create a data connection. You can edit the properties of a selected data connection.

5. Specify import parameters for the Oracle Business Intelligence (OBI) Enterprise Edition bridge. Help for each parameter is displayed when you hover over the value field.
   a. Optional: After you enter connection information for an import from a server, click Test Connection.
   b. For imports from databases and repositories, browse to select the specific assets that you want to import.
   c. Click Next.

6. If required, on the Identity Parameters screen, specify identity parameters for database assets or data models that you are importing. Consult the help for each selected parameter. Click Next.

7. Type a description for the import event and specify whether to run an express import or a managed import.

8. Click Import. The import area is created. The import runs and status messages are displayed.
   Leave the import window open to avoid the possibility that long imports time out.

Results

When the import completes, if you ran a managed import, analyze the imported assets in the Staged Imports tab of the import area.

If you ran an express import, take one of the actions that are listed in the following table.

Table 1. Choices after an express import

<table>
<thead>
<tr>
<th>In this case</th>
<th>Take this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the analysis shows problems that you must fix</td>
<td>The Staged Imports tab is displayed. Review the analysis results. If necessary, reimport the staged even.</td>
</tr>
<tr>
<td>If your administration settings require a preview</td>
<td>The View Share Preview screen is displayed. Preview the result of sharing the import.</td>
</tr>
<tr>
<td>If your administration settings do not require a preview</td>
<td>The assets are shared to the metadata repository. The Shared Imports tab is displayed. You can browse the assets on the Repository Management tab and work with them in other suite tools.</td>
</tr>
</tbody>
</table>
Chapter 3. Oracle Business Intelligence Enterprise Edition
bridge reference

Prerequisites, troubleshooting, and parameter information for the Oracle Business Intelligence Enterprise Edition import bridge.

About this bridge

The Oracle Business Intelligence Enterprise Edition bridge imports BI models, BI reports, and related implemented data resources such as database tables from Oracle Business Intelligence Enterprise Edition versions 10 and 11 (formerly Siebel Analytics).

You import the BI model from a file and the BI reports directly from the repository.

Prerequisites

Meet the following prerequisites before you use the bridge to import metadata.

- Ensure that the user name that you specify to connect to the presentation server has the necessary permissions to access the objects that you want to import.

- The Oracle BI Administration tool stores metadata in a Repository RPD file that you must convert to XML format for version 11 and to UDML format for version 10.
  - For version 11 take these steps to prepare the XML file.
    1. Run bi-init.cmd on Microsoft Windows or bi-init.sh on UNIX or Linux to launch a command prompt or shell window that is initialized to your Oracle instance. The files are located in the following directory: ORACLE_INSTANCE\bifoundation\OracleBIApplication\coreapplication\setup\bi-init.
    2. Use the biserverxmlgen command line utility to generate XML:
       biserverxmlgen -R file_path_and_name.rpd -P password -O file_path_and_name.xml -8. The option -8 is required.
    3. The bridge uses the generated XML file as input.
  - For version 10, prepare the UDML file by running the following command with nQUDMLGen command line utility: $OracleBIHome$\server\Bin\nQUDMLGen.exe -U Administrator -P Administrator -R file_path_and_name.rpd -O file_path_and_name.udml -N -O -8. The options -N, -Q, and -8 are required.

The bridge uses the generated XML file or UDML file as input. You must upload the file to either the metadata interchange server or the local client computer before you run the import.

Troubleshooting

To provide information to help the support team reproduce an issue, provide the following information:
• Repository RPD file and the user ID and password that are necessary to open it. By default this file is located in the \OracleBI\server\Repository directory. Alternately, you can connect to a live online repository by using the Oracle BI Administration tool and copy the local RPD file.
• Report metadata that is contained inside the OBIEE catalog. Reports are called requests in version 10 and analyses in version 11. To collect the report metadata, take the following steps:
  1. In OBIEE Catalog Manager, click File > Open Catalog.
  2. Take one of the following actions to specify the path to the catalog, selecting Read Only in each case:
     - In offline mode in version 10, specify OracleBIData/web/catalog/MyCatalog as the path, where MyCatalog is the name of the catalog.
     - In offline mode in version 11, point to Offline mode, v11.x: specify instance/bifoundation/OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/MyCatalog as the path, where instance is the name of the instance and MyCatalog is the name of the catalog.
     - In online mode, type in the OBI server URL, for example http://OBIServer:9704/analytics/saw.dll, where OBIServer is the name of your OBI computer.
  3. Click OK.
  4. Select the root folder in the tree and click File > Archive to create the archive file.
    Send the archive file to the support team.

Import parameters

The Oracle Business Intelligence Enterprise Edition bridge uses the following import configuration parameters.

Server URL
  Required. Specify the URL for the presentation server that you are importing metadata from.

User name
  Required. Type the user name to connect to the presentation server. This user must have the necessary permissions to access the objects that you want to import.

Login password
  Type the password to connect to the presentation server.

File location
  Select whether the file that you specify in the File field is on the metadata interchange server or on the local computer.

File
  Required. Browse the computer that you specified in the File location parameter to specify the name and path of the file to import:
  • For imports from version 11, specify an XML file.
  • For imports from version 10, specify a UDML file.

The Oracle BI Administration tool natively stores BI model metadata in a Repository RPD file. You import the BI model from the file, and you import the BI reports by using the Assets to import parameter, which accesses the presentation server repository. The BI model in the file that
you specify must match the contents of the BI model in the repository. To enable data lineage, the file should contain the models that are related to the reports that you select by using the **Assets to import parameter**.

Follow the directions in the bridge prerequisites to generate the correct import format from the RPD file. Upload it to the computer that you specify in the **File location** parameter.

**Variable values file**
Do not specify a value. Uploading a variable values file is not supported.

**Assets to import**
Required. Browse the presentation server repository to select folders and BI reports.

Alternately, you can specify list of folders and reports to import by path, with each path separated by a semicolon (;).

- The path to the root folder is `/`.
- The path to a shared folder is `/shared`.
- The path to the administrator user folder is `/users/administrator`.

To enable data lineage, the file that you specify in the **File** parameter must contain the models that are related to the reports that you select by using the **Assets to import parameter**.

**Incremental import**
Keep this parameter selected. When you reimport from the same source, the bridge uses cached information to determine which objects did not change since the previous import. Only changed objects are reimported. Using the cached information can increase performance for large imports.

For new imports, or when the cache is deleted or corrupted, the bridge imports all objects from the source regardless of the selection that is specified.

**Import joins**
You can import joins that are defined in the BI model. By default, joins are not imported.

**Import levels**
You can import levels and hierarchies. When the option is selected, levels and hierarchies that are defined in the BI model are imported. By default, they are not imported.

**Metadata consistency check**
Perform a consistency check on the selected metadata before it is imported into the metadata repository. It is possible to save metadata in source tools in ways that cause problems when the assets are imported into the metadata repository or used in other tools. For example, a foreign key might have no connection to a primary key or to an alternate key. In some cases, the metadata might be so semantically inconsistent that the bridge cannot import it.

The metadata consistency check returns warnings and errors in the log file.

**Basic check**
The default. Performs the minimum consistency checks necessary to validate the metadata, including checking for missing relationships and foreign keys that are not connected to primary or alternate keys.
In some cases, the basic check might be more rigorous than necessary and you can ignore certain errors or warnings.

**Detailed check**
Perform the basic check plus more advanced semantic checks specific to the type of metadata that is imported. This level can be used when the source tool does not have the ability to validate the metadata.

**No check**
Use with extreme caution. Selecting this option could result in the import of duplicates or invalid identities and might cause serious problems with your use of suite tools and the metadata repository.

---

**Upgrade requirements for users of Oracle Business Intelligence (OBI) Enterprise Edition bridge**

Users who upgrade to InfoSphere Information Server, Version 9.1, must be aware of the following requirements for importing metadata.

**Sharing and reimporting staged imports**

The method of identifying and reconciling business intelligence assets changed at InfoSphere Information Server, Version 9.1. If you reimport metadata that was shared you might create duplicate assets or delete existing assets.

To protect the integrity of your imported metadata, the following requirements are enforced at the import area level in InfoSphere Metadata Asset Manager:

- You cannot share staged imports that were created before the upgrade to version 9.1.
- You cannot reimport into the same import area.
- You can create a new import area by copying the settings of the existing area, as described in [Creating an import area from an existing staged import](http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/t_copying_staged_import.html).

**Important:** Before you create a new import area, see the technote [Upgrading the Oracle Business Intelligence Enterprise Edition bridge at IIS V9.1](http://publib.boulder.ibm.com/infocenter/iisinfsv/v9r1/topic/com.ibm.swg.im.iis.mmi.doc/topics/t_upgrading_obi_bridge.html). This technote can help you avoid creating duplicate assets or deleting existing assets.
Chapter 4. Identity parameters for imported assets

You specify values for identity parameters when you import database assets, logical data models, or physical data models. Specifying identity values helps prevent duplicate assets in the metadata repository and ensures that you do not overwrite assets by mistake.

When you use consistent values for identity parameters, suite users can readily identify which assets to use for such tasks as creating jobs, designating stewards, or assigning to terms.

You specify values on the Identity Parameters screen when you import database assets, logical data models, or physical data models by using InfoSphere Metadata Asset Manager.

**Database assets**

The bridges and connectors that import metadata from remote databases and repositories occasionally provide incomplete or inconsistent information about the host systems and databases that contain the assets that you are importing.

The identity of a database table has the following components:
- Host system name
- Database identity, consisting of database name, DBMS name, and DBMS server instance name
- Database schema name
- Database table name

Thus, host name, database name, database management system (DBMS) name, and DBMS server instance name are critical parts of the identity of the tables and schemas that they contain. If you were to import the same database assets by two different methods, and each method produced a different DBMS name, you could create duplicate assets in the metadata repository. Assets that have technically different identities but have identical content or contain the same child assets are potential duplicates.

To avoid duplicates and to ensure that your database assets are correctly identified, you specify values for identity parameters during the import process. Identity parameters are also valuable when you want the imported assets to be associated with a different host system, database, or DBMS than you imported them from. For example, you might want the assets to be identified with the host system and database that you use for test and production. For the host system, database, and schema parameters you can either type a name or select a host, database, or schema that is already in the metadata repository to associate the imported assets with.

Depending on the bridge or connector that you choose for import, you can specify values for the following identity parameters for database assets:

**Host system name**

The name of the computer that hosts the database. If you are importing from a database, you can specify a different name than the name of the
source computer. For example, you might specify the computer that will
host this database during development or production.

**Database name**
The name of the database that contains the imported schemas and tables.
You can specify a different name than the name of the source database.

**DBMS name**
The name of the DBMS that hosts the database. The DBMS name is part of
the identity of the target database. You can specify a different DBMS than
the one that hosts the source database. The DBMS name should be
appropriate for the value that you enter for database name.

**DBMS server instance name**
The name of the DBMS server instance, if it exists. Some database
management systems do not have the concept of DBMS server instance.
DBMS server instance name is part of the identity of the target database.
You can specify a different DBMS server instance name than the one that
hosts the source database. The DBMS server instance name should be
appropriate for the value that you enter for database name.

**Schema name**
The name of the schema that the imported tables belong to.

**Logical data model and physical data model assets**

In the metadata repository, the identity of a logical data model or physical data
model is a combination of the name of the model and a namespace value. You
specify the value for the **Model namespace** parameter on the Identity Parameters
screen when you import the model.

You can specify whatever value you want. The value does not have to correspond
to an actual namespace structure. You can type a namespace value or browse to
use an existing namespace value that is in the metadata repository.

By specifying a unique namespace value, you can distinguish between two
different logical or physical models that have the same name. If you are importing
logical and physical data models at the same time, the namespace value that you
specify is used for each of them.

**Important:** In imports created by using this bridge in version 8.7 of InfoSphere
Information Server, the identity of an imported logical or physical data model
includes a namespace value that contains the path of the model file. If you
imported the same data model with version 8.7, take either of the following
actions:

- To merge the current data model with the previously imported data model, use
  the same value for **Model namespace** that was provided for you in the original
  import. You can copy this namespace value by browsing to the previously
  imported logical or physical data model and displaying the model on the
  **Repository Management** tab.
- To create a different identity for the current data model, specify a value for
  **Model namespace** that is different from the namespace value of the previously
  imported data model. The current data model is imported as a unique asset,
  while the previously imported model remains in the metadata repository. If
  desired, a Common Metadata Administrator can delete the previously imported
data model on the **Repository Management** tab.
Chapter 5. Business intelligence assets

Business intelligence (BI) assets are used by BI tools to organize reports and models that provide a business view of data. These assets include BI reports, BI models, BI collections, and cubes.

You can use bridges to import BI assets from tools such as IBM Cognos and SAP BusinessObjects.

It is good practice when importing BI assets to simultaneously import the database tables that BI reports are based on. You can then use InfoSphere Metadata Workbench to create data lineage reports that show the relationship between the database tables, the jobs that use the database tables, and the BI reports that are based on the tables.

You can use InfoSphere Metadata Asset Manager to browse and delete BI assets and manage duplicate BI assets.

**Asset types**

The following table lists and defines the types of BI assets that are stored in the metadata repository of InfoSphere Information Server.

<table>
<thead>
<tr>
<th>Asset type</th>
<th>Definition</th>
<th>Components of the identity of the asset</th>
<th>Contained asset types</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI server</td>
<td>When a BI tool supports multiple servers on a single host computer, the BI server value is the name of the source tool server. When a BI tool supports a single server per host computer, the BI server value is the name or IP address of the host system. BI servers are displayed in InfoSphere Metadata Workbench and on the Import tab of InfoSphere Metadata Asset Manager.</td>
<td>BI server name</td>
<td>BI folder</td>
</tr>
<tr>
<td>Asset type</td>
<td>Definition</td>
<td>Components of the identity of the asset</td>
<td>Contained asset types</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
<td>----------------------------------------</td>
<td>-----------------------</td>
</tr>
</tbody>
</table>
| BI folder  | The folder structure that contains BI models, or BI reports, or both in the source tool. BI folders can also contain other BI folders. BI folders are displayed in InfoSphere Metadata Workbench and on the Import tab of InfoSphere Metadata Asset Manager. | • BI folder name  
• Identity of the BI server, or, for subfolders, the identity of the containing BI folder | BI folder, BI model, and BI report |
| BI model   | A grouping of BI data collection views that are relevant to a BI application. | • BI model name  
• Identity of BI folder | Cube, BI collection, BI join, BI hierarchy, and BI filter |
| BI collection | A data structure that provides a view of data that is stored in databases and files. In dimensional modeling, these structures are known as dimensions and fact tables. BI collections are the data sources of BI reports. | • BI collection name  
• BI collection namespace  
• Identity of the BI model that contains the collection, or, for subcollections, the identity of the BI collection that contains the subcollection | BI collection member, BI level, BI hierarchy, and BI filter. BI collections can contain other BI collections. |
| BI collection member | The basic abstraction of a data value that is projected from a database column. BI collection members define the structure of the collection that owns them. There are two types of members: regular and measure. Regular members are dimension attributes that describe the characteristics and semantics of the owner collection. Measures represent analytic values that define a measurement entity in a fact collection. | • BI collection member name  
• Identity of the BI collection |
### Table 2. BI assets (continued)

<table>
<thead>
<tr>
<th>Asset type</th>
<th>Definition</th>
<th>Components of the identity of the asset</th>
<th>Contained asset types</th>
</tr>
</thead>
</table>
| BI level      | An asset that defines a logical step in the order of a BI hierarchy. A BI level consists of one or more BI collection members of the same BI collection that are related and function as a logical unit. | • BI level name  
• Identity of the BI collection                                           | BI level element                                      |
| BI level element | An associative class that assigns a BI collection member to a specific level within the collection.                                                                                           | • Identity of the BI collection member  
• Identity of the BI level                                                 |                                             |
| Cube          | A subset of a BI model that consists of a set of related analytic values that share the same dimensionality.                                                                                     | • Cube name  
• Cube namespace  
• Identity of the BI model                                               | Cube dimension and cube measure  
| Cube dimension | An associative class that connects a cube to dimensions in the BI collection that are relevant to the analytic values of the cube. A cube dimension references the BI collection from which the dimension is derived and the relevant dimension hierarchy of the cube. | • Identity of the cube  
• Identity of the BI collection                                               |                                             |
| Cube measure  | An associative class that connects a cube to BI collection members that are measures.                                                                                                                    | • Identity of the cube  
• Identity of the BI collection member                                        |                                             |
| BI filter     | A filtering constraint on the source data that is viewed through a BI collection. Filters are either local or global. A local filter is owned by a single BI collection. A global filter is owned by the BI model and by one or more collections. | • BI filter name  
• BI filter namespace  
• Either the identity of the containing BI model or the containing BI collection |                                             |
Table 2. BI assets (continued)

<table>
<thead>
<tr>
<th>Asset type</th>
<th>Definition</th>
<th>Components of the identity of the asset</th>
<th>Contained asset types</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI hierarchy</td>
<td>An organizational structure that defines an ordering or relationship of data within a BI collection.</td>
<td>• BI hierarchy name&lt;br&gt;• BI hierarchy namespace&lt;br&gt;• Either the identity of the containing BI model or the containing BI collection</td>
<td>BI hierarchy member</td>
</tr>
<tr>
<td>BI hierarchy member</td>
<td>An asset that orders BI levels within a hierarchy structure.</td>
<td>• Identity of the BI hierarchy&lt;br&gt;• Identity of the BI level</td>
<td></td>
</tr>
<tr>
<td>BI join</td>
<td>An asset that joins two database tables (a physical join) or two BI collections (a logical join). The physical join defines the data source of a BI collection and the logical join is used in a star schema between fact and dimension collections.</td>
<td>• BI join name&lt;br&gt;• BI join condition&lt;br&gt;• Identity of the BI model</td>
<td>BI report section, BI report field, and BI report query</td>
</tr>
<tr>
<td>BI report</td>
<td>A business intelligence report that is based on information in a database or a BI model.</td>
<td>• BI report name&lt;br&gt;• Identity of the BI folder</td>
<td>BI report section and BI report query</td>
</tr>
<tr>
<td>BI report section</td>
<td>An asset that defines the presentation of a section of a BI report. A BI report section is a grouping of BI report fields.</td>
<td>• BI report section name&lt;br&gt;• Either the identity to the BI report or the identity of the containing BI report section</td>
<td>BI report field. BI report sections can contain other BI report sections.</td>
</tr>
<tr>
<td>Asset type</td>
<td>Definition</td>
<td>Components of the identity of the asset</td>
<td>Contained asset types</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
</tbody>
</table>
| BI report field   | A field in a BI report that is typically based on a database column. Some BI report fields, including page numbers and section headers, are not data fields. Some BI report fields contain links, known as report drill-through, to child BI reports. In the Repository Management tab of IBM InfoSphere Metadata Asset Manager you can drill through a BI report field to see the child BI report. | • BI report field name  
• Identity of the BI report section                  |                                                                    |
| BI report query   | A query on a database or a BI model whose result set populates a BI report section.                                                                                                                                 | • BI report query name  
• BI report query namespace  
• Identity of the BI report |
| BI report query item | An asset that defines the data values that are associated with a BI report field by defining a column in a BI report query.                                                                                                                           | • BI report query item name  
• Identity of the BI report query                           |                                                                    |
Appendix A. Product accessibility

You can get information about the accessibility status of IBM products.

The IBM InfoSphere Information Server product modules and user interfaces are not fully accessible. The installation program installs the following product modules and components:
- IBM InfoSphere Business Glossary
- IBM InfoSphere Business Glossary Anywhere
- IBM InfoSphere DataStage
- IBM InfoSphere FastTrack
- IBM InfoSphere Information Analyzer
- IBM InfoSphere Information Services Director
- IBM InfoSphere Metadata Workbench
- IBM InfoSphere QualityStage

For information about the accessibility status of IBM products, see the IBM product accessibility information at [http://www.ibm.com/able/product_accessibility/index.html](http://www.ibm.com/able/product_accessibility/index.html).

Accessible documentation

Accessible documentation for InfoSphere Information Server products is provided in an information center. The information center presents the documentation in XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you to set display preferences in your browser. It also allows you to use screen readers and other assistive technologies to access the documentation.

The documentation that is in the information center is also provided in PDF files, which are not fully accessible.

IBM and accessibility

See the [IBM Human Ability and Accessibility Center](http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.
Appendix B. Contacting IBM

You can contact IBM for customer support, software services, product information, and general information. You also can provide feedback to IBM about products and documentation.

The following table lists resources for customer support, software services, training, and product and solutions information.

Table 3. IBM resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description and location</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Support Portal</td>
<td>You can customize support information by choosing the products and the topics that interest you at <a href="http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server">www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server</a></td>
</tr>
<tr>
<td>Software services</td>
<td>You can find information about software, IT, and business consulting services, on the solutions site at <a href="http://www.ibm.com/businesssolutions/">www.ibm.com/businesssolutions/</a></td>
</tr>
<tr>
<td>My IBM</td>
<td>You can manage links to IBM Web sites and information that meet your specific technical support needs by creating an account on the My IBM site at <a href="http://www.ibm.com/account/">www.ibm.com/account/</a></td>
</tr>
<tr>
<td>Training and certification</td>
<td>You can learn about technical training and education services designed for individuals, companies, and public organizations to acquire, maintain, and optimize their IT skills at <a href="http://www.ibm.com/software/sw-training/">http://www.ibm.com/software/sw-training/</a></td>
</tr>
<tr>
<td>IBM representatives</td>
<td>You can contact an IBM representative to learn about solutions at <a href="http://www.ibm.com/connect/ibm/us/en/">www.ibm.com/connect/ibm/us/en/</a></td>
</tr>
</tbody>
</table>
Appendix C. Accessing and providing feedback on the product documentation

Documentation is provided in a variety of locations and formats, including in help that is opened directly from the product client interfaces, in a suite-wide information center, and in PDF file books.

The information center is installed as a common service with IBM InfoSphere Information Server. The information center contains help for most of the product interfaces, as well as complete documentation for all the product modules in the suite. You can open the information center from the installed product or from a Web browser.

Accessing the information center

You can use the following methods to open the installed information center.

• Click the Help link in the upper right of the client interface.

  Note: From IBM InfoSphere FastTrack and IBM InfoSphere Information Server Manager, the main Help item opens a local help system. Choose Help > Open Info Center to open the full suite information center.

• Press the F1 key. The F1 key typically opens the topic that describes the current context of the client interface.

  Note: The F1 key does not work in Web clients.

• Use a Web browser to access the installed information center even when you are not logged in to the product. Enter the following address in a Web browser: http://host_name:port_number/inforcenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/ic-homepage.html. The host_name is the name of the services tier computer where the information center is installed, and port_number is the port number for InfoSphere Information Server. The default port number is 9080. For example, on a Microsoft® Windows® Server computer named isdocs2, the Web address is in the following format: http://isdocs2:9080/inforcenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/iisinfsrv_home.html.

A subset of the information center is also available on the IBM Web site and periodically refreshed at http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/index.jsp.

Obtaining PDF and hardcopy documentation

• A subset of the PDF file books are available through the InfoSphere Information Server software installer and the distribution media. The other PDF file books are available online and can be accessed from this support document: https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1

• You can also order IBM publications in hardcopy format online or through your local IBM representative. To order publications online, go to the IBM Publications Center at http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss
Providing comments on the documentation

Your feedback helps IBM to provide quality information. You can use any of the following methods to provide comments:

- To comment on the information center, click the Feedback link on the top right side of any topic in the information center.
- Send your comments by using the online readers' comment form at www.ibm.com/software/awdtools/rcf/
- Send your comments by e-mail to comments@us.ibm.com. Include the name of the product, the version number of the product, and the name and part number of the information (if applicable). If you are commenting on specific text, include the location of the text (for example, a title, a table number, or a page number).
- You can provide general product feedback through the Consumability Survey at www.ibm.com/software/data/info/consumability-survey
Notices and trademarks

This information was developed for products and services offered in the U.S.A.

Notices

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

The following terms are trademarks or registered trademarks of other companies:

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

The United States Postal Service owns the following trademarks: CASS, CASS Certified, DPV, LACS\textsuperscript{link}, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS and United States Postal Service. IBM Corporation is a non-exclusive DPV and LACS\textsuperscript{link} licensee of the United States Postal Service.

Other company, product or service names may be trademarks or service marks of others.
Index

B
BI assets 11
BI metadata 1
BI models 11
BI reports 11
bridge parameters
  Oracle Business Intelligence Enterprise Edition bridge 5
business intelligence assets 11

C
cubes 11
customer support
  contacting 19

E
express import 3

I
identity parameters 9
importing metadata 3
InfoSphere Metadata Asset Manager
  importing assets 3

L
legal notices 23

M
managed import 3

O
Oracle Business Intelligence (OBI)
  Enterprise Edition bridge 8
Oracle Business Intelligence Enterprise Edition bridge 5

P
product accessibility
  accessibility 17
product documentation
  accessing 21

S
software services
  contacting 19
support
  customer 19

trademarks
  list of 23